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Abstract: Development of Local History Interactive Learning Media Material
for National and Regional Figures in Struggling for Independence Class XI SMA
Negeri 1 Bandar. This research is motivated by the lack of use of interactive learning
media in history learning at SMA Negeri 1 Bandar. In the implementation of historical
learning, the teacher is more focused on the material available in textbooks. The
objectives of this study are: (1) To develop interactive learning media for local history,
material for national and regional figures in the struggle for independence for class
X1 SMA Negeri 1 Bandar and (2) To determine the feasibility of developing local
history interactive learning media. This study uses a research and development
method with a Five-Stage (Sturdy) Model which includes (1) Preliminary Research,
(2) Product Development, (3) Product Validation, (4) Product Trial, and (5)
Dissemination. The population in this study were students of class XI IPS SMA
Negeri 1 Bandar, with a research sample of class XI IPS 1. The data collection
technique used a questionnaire. The data collection instruments used were material
expert validation instruments, media expert validation instruments and product testing
instruments to students. The data analysis technique of this research is qualitative and
quantitative data analysis. The results showed that the local history-based interactive
learning media developed got a percentage score by material experts of 95% with a
very decent category, media experts 95.68% with a very decent category. The results
of product trials for a limited group get a percentage value of 89.79% in the very
feasible category, and product trials for a broad group get a percentage value of
91.37% in a very feasible category. Based on the percentage of these results, it can be
concluded that the interactive learning media developed was categorized as very
feasible to be used in the historical learning process in schools.
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Abstrak: Pengembangan Media Pembelajaran Interaktif Sejarah Lokal Materi
Tokoh Nasional dan Daerah dalam Memperjuangkan Kemerdekaan Kelas XI
SMA Negeri 1 Bandar. Penelitian ini dilatarbelakangi kurangnya penggunaan media
pembelajaran interaktif pada pembelajaran sejarah di SMA Negeri 1 Bandar. Dalam
pelaksanaan pembelajaran sejarah, guru lebih terfokus pada materi yang tersedia pada
buku paket saja. Tujuan dalam penelitian ini yaitu: (1) Untuk mengembangkan media
pembelajaran interaktif sejarah lokal materi tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan untuk kelas X1 SMA Negeri 1 Bandar dan (2) Untuk
mengetahui  kelayakan media pembelajaran interaktif sejarah lokal yang
dikembangkan. Penelitian ini menggunakan metode penelitian dan pengembangan
dengan Model Lima Tahap (Mantap) yang meliputi (1) Penelitian Pendahuluan, (2)
Pengembangan Produk, (3) Validasi Produk, (4) Uji Coba Produk, dan (5) Diseminasi.
Populasi dalam penelitian ini adalah siswa kelas X1 IPS SMA Negeri 1 Bandar,
dengan sampel penelitian kelas XI IPS 1. Teknik pengumpulan data menggunakan
angket. Instrumen pengumpulan data yang digunakan yaitu instrumen validasi ahli
materi, instrumen validasi ahli media dan instrumen uji coba produk kepada siswa.
Teknik analisis data penelitian ini yaitu analisis data kualitatif dan kuantitatif. Hasil
penelitian menunjukkan bahwa media pembelajaran interaktif berbasis sejarah lokal
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yang dikembangkan mendapatkan persentase nilai oleh ahli materi sebesar 95%
dengan kategori sangat layak, ahli media 95,68% dengan kategori sangat layak. Hasil
uji coba produk kepada kelompok terbatas mendapatkan persentase nilai sebesar
89,79% dengan kategori sangat layak, dan uji coba produk kelompok luas
mendapatkan persentase nilai 91,37% dengan kategori sangat layak. Berdasarkan
persentase hasil tersebut dapat disimpulkan bahwa media pembelajaran interaktif
yang dikembangkan mendapatkan kategori sangat layak untuk digunakan pada proses

pembelajaran sejarah di sekolah.

Kata Kunci: Media Pembelajaran Interaktif, Pembelajaran Sejarah, R&D.

PENDAHULUAN

Pendidikan dewasa ini ditandai
dengan adanya kemajuan pada ilmu
pengetahuan dan teknologi sehingga hal
tersebut terlihat jelas dimana melalui
proses pembelajaran yang dilakukan di
sekolah pada saat ini telah mengalami
perubahan. Proses pembelajaran yang
dilaksanakan di sekolah tidak lagi
melibatkan guru sebagai pemeran utama
(teacher center) melainkan guru harus
berperan sebagai seorang fasilitator
(memfasilitasi) siswa dalam proses
pembelajaran sehingga siswa secara aktif
dapat melangsungkan pembelajaran baik
secara mandiri ataupun berkelompok
dengan siswa lainnya. Berdasarkan hal
tersebut, suatu langkah yang dapat
dilakukan oleh guru untuk mendukung
berlangsungnya pendidikan pada dewasa
ini ialah dengan  merencanakan,
mengembangkan ataupun menghasilkan
perangkat pembelajaran berbasis digital.
Salat satu perangkat pembelajaran yang
saat ini sangat perlu dikembangkan yaitu
media pembelajaran interaktif.

Menurut Suryani, dkk (2018: 202)
media pembelajaran interaktif adalah
media yang dapat memastikan bahwa
akan adanya interaksi antar media
dengan kemampuan siswa. Pada media
pembelajaran interaktif akan berisikan
perpaduan antara teks, grafis, video, dan
audio yang tentunya akan lebih menarik.
Selanjutnya, keterlibatan dari siswa akan
lebih berperan sehingga setiap siswa

mampu melangsungkan pembelajaran
sesuai dengan kemampuan berpikir
mereka. Selanjutnya, Daryanto (2020:
53) menjelaskan  tentang  media
pembelajaran interaktif adalah
multimedia vyang terdiri dari alat
pengontrol dalam mengoperasikannya. Si
pengguna media dapat melakukan apa
yang diinginkannya ataupun apa yang
dibutuhkannya terhadap media tersebut.
Melalui alat pengontrol ini maka siswa
dapat mengoperasikan media tersebut
untuk mendapatkan informasi yang
merkeka kehendaki dengan cepat. Selain
itu, Surjono (2017: 41) juga menjelaskan
bahwa media pembelajaran interaktif
adalah sebuah alat pembelajaran yang
mengkombinasi tulisan, gambar, grafik,
suara, video, dan animasi yang secara
terpadu dengan menggunakan komputer
dan sejenisnya sebagai alat bantu dalam
penggunaannya. Dalam penggunaan
media pembelajaran interaktif ini, maka
siswa (pengguna media) dapat secara
aktif berinteraksi dengan tampilan yang
disediakan media tersebut sehingga
tercapailah tujuan pembelajaran yang
telah ditetapkan.

Menurut  Mudlofir (2016: 128)
media dalam pembelajaran menjadi suatu
komponen dari sistem pembelajaran
(perangkat pembelajaran) yang memiliki
fungsi dan kedudukan yang sangat
penting bagi keberhasilan pembelajaran.
Hal tersebut memiliki arti bahwa media
pembelajaran memiliki posisi strategis



sebagai bagian yang tak terpisahkan
dalam pembelajaran. Tanpa adanya
media dalam pembelajaran, maka proses
pembelajaran tidak akan pernah terjadi.
Kemudian, Zainiyati (2017: 102)
mengungkapkan bahwasanya dalam
penggunaan dan pemilihan media dalam
pembelajaran, maka seorang pengajar
haruslah pandai dalam memilihkan
media apa yang dipakainya atau
membantunya dalam  mengirimkan
materi pelajaran ke siswa.

Selain siswa dapat menerima materi
pembelajaran melalui media
pembelajaran tersebut, siswa juga dapat
melakukan umpan balik atau respon serta
berpasrtisipasi  secara aktif dalam
pembelajaran.  Penggunaan  media
pembelajaran interaktif sangatlah efektif
dan efisien bagi guru dan peserta didik
dalam mata pelajaran apapun, baik mata
pelajaran sains ataupun sosial yang
terkhususnya pada mata pelajaran
sejarah.  Penggunaan dari  media
pembelajaran yang sesuai akan dapat
menghindari terjadinya hambatan yang
terjadi selama dalam proses
pembelajaran. Pada umumnya hambatan
dalam pembelajaran tersebut seperti
verbalisme, salah penafsiran, dan
kurangnya perhatian atau tanggapan dari
peserta didik.

Dalam pembelajaran sejarah yang
berdasarkan kurikulum 2013 dijelaskan
bahwasanya pembelajaran sejarah di
SMA terdiri atas dua kategori pelajaran
sejarah, yaitu sejarah Indonesia untuk
kelompok IPA dan IPS, dan sejarah
peminatan untuk kelompok IPS saja.
Selanjutnya pada proses pembelajaran
sejarah disekolah, guru sejarah perlu
melakukan sisipan materi tentang sejarah
lokal. Hal tersebut tentulah sangat
penting dikarenakan melalui
pembelajaran sejarah lokal ini, maka
siswa akan memiliki kesadaran dan
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keingintahuan mengenai perkembangan
kehidupan lingkungannya (Kusnoto, dkk,
2017: 132).

Menurut Priyadi (2019: 7) arti lokal
memiliki makna tempat atau ruang yang
telah dibatasi. Pada konteks sejarah lokal
memiliki arti bahwa sejarah atau
peristiwa yang telah dituliskan oleh para
ahli yang telah terjadi pada suatu daerah
dan ruang tertentu. Misalnya suatu ruang
tempat tinggal. Ruang pada konteks ini
diartikan lintas  kecamatan, Kkota,
kabupaten, atau provinsi. Abdullah
(Kusnoto, dkk, 2017: 129) mengatakan
bahwa cakupan sejarah lokal tidak
berbelit-belit, hanya mencakup tempat
dan ruang saja. Tempat dan ruang yang
diartikan ini bisa merujuk pada salah satu
tempat daerah tertentu yang cakupannya
desa, kecamatan, kota, hingga provinsi.

Pembelajaran  sejarah  berbasis
sejarah lokal merupakan sebuah materi
pelajaran yang diberikan guru dalam
memperkenalkan  dan  menjelaskan
kepada siswa tentang suatu Kisah,
peristiwa dan kehidupan yang pernah
terjadi pada masa lampau di sekitar
lingkungan tempat tinggal peserta didik
dan  memiliki  keterkaitan dengan
kehidupan masa kini hingga pada masa
yang akan  mendatang. Dalam
melangsungkan pembelajaran sejarah
yang menarik tentunya hal ini tidak
terlepas dari  peran guru dalam
menciptakan suasana belajar yang
menyenangkan dan juga cara guru
tersebut dalam menyampaikan materi
pembelajaran sejarah kepada siswa.
Sebagai guru profesional pada era
modern sekarang ini, seorang guru
sejarah harus mampu mengembangkan
sebuah media pembelajaran interaktif
dengan tujuan untuk menghasilkan
proses pembelajaran sejarah yang aktif
dan menarik.

Salah satu media pembelajaran



Simamora, Reny Sabrina, dkk. Pengembangan Media Pembelajaran...

interaktif yang dimaksudkan seperti
media pembelajaran yang dikembangkan
dengan berbantuan pada aplikasi
Microsoft Office Powerpoint.
Penggunaan powerpoint sebagai media
pembelajaran disekolah sudah tidak asing
lagi, namun berdasarkan perkembangan
informasi dan teknologi serta kebutuhan
siswa pada saat ini, maka powerpoint
yang dikembangkan oleh guru tentunya
harus lebih interaktif dan memuat
tampilan lebih menarik yang terdiri atas
materi dalam bentuk teks (poin-poin
materi), gambar, video serta audio. Selain
itu materi yang disajikan tentu harus
mudah dipahami oleh siswa, tidak full text
(penuh tulisan), dan dengan adanya
penggunaan slide powerpoint interaktif
ini  akan menghasilakan ~ proses
pembelajaran dua arah yang tentunya
akan menciptakan pembelajaran sejarah
yang aktif.

Berdasarkan penelitian awal (pra
penelitian) yang dilakukan kepada siswa
SMA Negeri 1 Bandar pada tanggal 06
Oktober 2021 melalui pesan WhatsApp,
peneliti melakukan kegiatan wawancara
tidak terstruktur dengan Khairu Nisa
Damanik (kelas XI IPS 1), Vera Butar-
butar (kelas XI IPS 2) dan Samuel Joshua
Juneuro Hutahaean (kelas XII IPS 1).
Dari hasil wawancara tersebut diperoleh
informasi  bahwasanya pembelajaran
sejarah di SMA Negeri 1 Bandar hingga
saat ini masih hanya memanfaatkan buku
teks sejarah atau buku cetak yang
berukuran besar dan tebal sebagai salah
satu media pembelajaran utama yang
digunakan oleh guru sejarah. Kemudian,
guru sejarah menggunakan media
pembelajaran lain seperti powerpoint
dalam proses pembelajaran, namun
powerpoint yang disajikan guru hanya
berisikan tulisan yang padat dan tidak
disertai dengan desain yang menarik.

Selain itu, guru sejarah belum

pernah menyajikan media pembelajaran
interaktif ~ yang  mengkombinasikan
gambar, video, dan audio. Padahal siswa
menyukai media pembelajaran interaktif
tersebut. Dalam pembelajaran sejarah,
guru sejarah masih bersifat teacher
center serta guru sejarah sering sekali
hanya memerintahkkan siswa untuk
meringkas materi dan mengerjakan soal-
soal latihan yang tersedia dibuku paket.

Informasi lainnya dipaparkan juga
bahwa guru sejarah di SMA Negeri 1
Bandar masih kurang kreatif dan inovatif
dalam mengembangkan media
pembelajaran interaktif yang lebih
menarik dalam pembelajaran sejarah dan
sehingga hal ini mengakibatkan siswa
merasa sulit dalam memahami pelajaran
yang diberikan dan cenderung merasa
kurang tertarik dalam belajar sejarah.
Untuk saat ini proses pembelajaran di
SMA Negeri 1 Bandar sudah mulai
memanfaatkan teknologi digital dalam
pembelajaran. Hal tersebut terlihat
dengan tersedianya komputer dan
proyektor yang dapat dimanfaatkan
dalam pembelajaran disekolah.
Berdasarkan permasalahan  tersebut,
maka peneliti ingin melakukan penelitian
dengan judul “Pengembangan Media
Pembelajaran Interaktif Sejarah Lokal
Materi Tokoh Nasional dan Daerah
dalam Memperjuangkan Kemerdekaan
Kelas XI SMA Negeri 1 Bandar”.

METODE

Penelitian ini merupakan jenis
penelitian dan pengembangan (Research
and Development). Menurut Sugiyono
(2018: 407), penelitian dan
pengembangan adalah metode penelitian
yang digunakan untuk membuat suatu
produk tertentu dan menguji
keefektifannya. Selanjutnya, menurut
Borg & Gall (Setyosari, 2016: 276)
mengungkapkan bahwa penelitian dan



pengembangan adalah suatu proses
penelitian yang digunakan untuk tujuan
mengembangkan sebuah produk dalam
dunia pendidikan. Hasil dari yang
dilakukan ini tidaklah hanya
mengembangkan  terhadap  sebuah
produk yang telah ada tetapi juga untuk
menperoleh pengetahuan dari sebuah
permasalahan yang ada.

Selain itu, Sukmadinata (2017: 164)
mengungkapkan penelitian dan
pengembangan itu merupakan proses
mengembangkan produk baru atau
bahkan juga menyempurnakan yang telah
ada  sebelumnya.  Penelitian  dan
pengembangan merupakan metode yang
berbeda dari penelitian biasanya yang
hanya menghasilkan saran-saran tertentu
untuk perbaikan, sedangkan dalam
penelitian dan pengembangan ini akan
menghasilkan sebuah produk yang
langsung dapat digunakan. Dalam
penelitian dan pengembangan terdapat
macam bentuk pengembangan yang
dapat dipakai sesuai dengan kebutuhan
dalam penelitian, diantaranya yaitu
model Borg and Gall, ADDIE, ASSURE,
4D, Sugiyono dan Model Lima Tahap
(Mantap).

Penelitian ini menggunakan jenis
Pengembangan Model Lima Tahap
(Mantap). Pengembangan Model Lima
Tahap (Mantap) adalah model penelitian
pengembangan yang dihasilkan pada
tahun 2019 oleh Sumarni, Istiningsih,
dan Nugraheni. Pengembangan Model
Lima Tahap (Mantap) merupakan hasil
pengembangan dari model Borg and Gall
yang kemudian dikelompokkan kembali
berdasarkan tipe penelitian pada masing
tahap. Model Lima Tahap (Mantap)
terdiri atas lima tahapan penelitian dan
pengembangan yang mana tujuan dari
pengelompokkan tahapan tersebut yaitu
untuk memudahkan para pengguna
langkah penelitian dan pengembangan
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terkhususnya bagi para pemula (Najuah,
dkk, 2021: 69).

Yang menjadi populasi dalam
penelitian ini yaitu kelas XI IPS SMA
Negeri 1 Bandar. Dan yang menjadi
sampel dalam penelitian yaitu kelas XI
IPS 1 dengan jumlah 36 siswa. Adapun
teknik  pengambilan  sampel yang
digunakan dalam penelitian ini yaitu
teknik  non  probability  sampling
(sampling  purposive) atau teknik
penentuan sampel dalam penelitian
dengan  menetapkan  pertimbangan
tertentu. Yang menjadi pertimbangan
bagi peneliti dalam memilih kelas X1 IPS
1 sebagai sampel dalam penelitian ialah
dikarenakan pada kegiatan pra penelitian
yang telah dilakukan, didapatkan
informasi bahwa siswa yang berada
dikelas  tersebut  telah  memiliki
handphone/smartphone  pribadi, dan
kepala SMA Negeri 1 Bandar
merekomendasikan  kepada  peneliti
untuk menjadikan kelas XI IPS 1 ini
sebagai sampel dalam penelitian.

Penelitian ini menggunakan teknik
pengumpulan data dengan penyebaran
angket atau kuesioner. Dalam penelitian
ini terdapat tiga kategori angket, yaitu (1)
angket validasi media kepada ahli media
untuk memperoleh penilaian (kelayakan)
dari media yang dikembangkan, (2)
angket validasi materi kepada ahli materi
untuk memperoleh penilaian (kelayakan)
atas materi yang disusun, dan (3) angket
uji kelayakan media kepada siswa.
Penelitian ini terdiri atas tiga jenis angket
sebagai instrumen pengumpulan data.
Instrumen penelitian tersebut selanjutnya
dikembangkan dengan menggunakan
skala likert berbentuk check list.

Selanjutnya, Penelitian ini memakai
teknik analisis data kualitatif dan analisis
data kuantitatif. Analisis data kualitatif
diperolen melalui saran yang terdapat
pada angket atau pendeskripsian hasil
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validasi dari ahli media, ahli materi, dan
uji coba siswa. Sedangkan analisis data
kuantitatif diperoleh melalui penyebaran
angket validasi yang menggunakan skala
likert (check list) yang selanjutnya data
tersebut dikelola secara kuantitatif
dengan menggunakan rumus:

Jumlah skor validator

x100%

B Jumlah skor jawaban teringgi

Keterangan:
P = Besar Persentase Setiap Aspek
100% = Konstanta
Kemudian hasil persentase yang
diperoleh selanjutnya ditentukan dengan
berpedoman pada penetuan tingkat
validitas menggunakan skala penilaian
kualifikasi produk, yaitu sebagai berikut:
Skor

Interpr i
Persentase terpretasi
81% - 100% Sangat Pantas
61% - 80% Pantas

41% - 60%
21% - 40%
0% - 20%

Cukup Pantas
Tidak Pantas
Sangat Tidak Pantas
(Sumber: Riduwan, 2007)

PEMBAHASAN

Penelitian ini dilakukan dengan
tujuan untuk menghasilkan produk yang
berupa media pembelajaran interaktif
berbasis sejarah lokal materi tokoh
nasional dan daerah dalam
memperjuangkan kemerdekaan untuk
kelas XI SMA Negeri 1 Bandar. Media
pembelajaran interaktif ini
dikembangkan dengan menggunakan
Model Pengembangan Lima Tahap
(Mantap) yang dikembangkan oleh
Sumarni, dimana dalam penelitian ini
terdiri dari lima tahap, yaitu: Tahap |
(Penelitian  Pendahuluan), Tahap I
(Pengembangan Produk), Tahap 1l
(Validasi Produk), Tahap 1V (Uji Coba
Produk), dan Tahap V (Diseminasi).

Berikut ini akan dijelaskan hasil

penelitian dan pembahasan dari setiap

tahap pengengembangannya.

1. Tahap I: Penelitian Pendahuluan
Data yang diperoleh dari penelitian

pendahuluan adalah sebagai berikut.

a. Kegiatan Pembelajaran Sejarah di

Sekolah

1) Berdasarkan kebijakan yang
dikeluarkan oleh dinas
pendidikan tentang kegiatan
pembelajaran dimasa pandemi
Covid-19, maka pembelajaran di
SMA Negeri 1 Bandar dilakukan
secara 50% tatap muka (luring),
dan 50% dalam jaringan
(Online/Daring).

2) Metode pembelajaran sejarah
yang diterapkan oleh guru
sejarah di kelas X1 IPS 1 adalah
metode ekspositori, dimana guru
sejarah menyampaikan materi
pembelajaran  secara  verbal
(dengan kata-kata), dan
selanjutnya guru memerintahkan
siswa untuk membuat
rangkuman serta catatan
mengenai materi pembelajaran
baik dari yang telah disampaikan
olen guru maupun dari buku
paket, dan selanjutnya siswa
diperintahkan untuk
mengerjakan  soal-soal  yang
terdapat pada buku paket.

3) Bahan ajar yang digunakan yaitu
buku paket Sejarah Indonesia
(Kementerian Pendidikan dan
Kebudayaan Republik Indonesia
2017).

4) Guru sejarah belum pernah
mengembangkan sebuah media
pembelajaran interaktif.

5) Guru sejarah lebih berfokus
kepada materi pembelajaran
yang tersedia pada buku paket.



Media Pembelajaran yang
digunakan Guru Sejarah

Dalam melangsungkan proses
pembelajaran sejarah di kelas,
media pembelajaran yang
digunakan oleh guru yaitu buku
paket, papan tulis,  spidol,
penghapus papan tulis, peta dan
sesekali guru menggunakan
proyektor (Infocus) untuk
menampilkan slide Powerpoint dari
hasil diskusi/kerja kelompok siswa.
Sebenarnya media pembelajaran
yang tersedia di sekolah telah
memadai untuk melakukan
pembelajaran berbasis teknologi,
sekolah telah memiliki koneksi
internet  (Wifi), laboratorium
komputer, dan juga seluruh siswa
telah memiliki Handphone
(Android/Smartphone). Tetapi, guru
masih  kurang terampil dalam
melangsungkan pembelajaran
sejarah yang memanfaatkan
kecanggihan teknologi saat ini.
Tahap II: Pengembangan Produk
Pada tahapan ini merupakan tahapan

dalam merancang dan mengembangkan
media pembelajaran interaktif Adapun
tahapan pengembangan produk akan
diuraikan sebagai berikut:

a.

Menyusun Rencana Pelaksanaan
Pembelajaran (RPP)

Penyusunan RPP menggunakan
format penulisan RPP SMA dengan
berpedoman pada langkah-langkah
penyusunan RPP pada kurikulum
2013 edisi revisi (terbaru). Setelah
RPP disusun, selanjutnya
dikonsultasikan kepada guru sejarah
di sekolah untuk tujuan
menyesuaikannya.  Selain itu,
penyusunan RPP ini dimaksudkan
guna menjadi pedoman dan acuan
dalam  mengembangkan  materi
dalam produk yang dikembangkan.
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b. Mengumpulkan dan Menyusun Draf

Materi

Setelah RPP dikembangkan dan
disusun, maka selanjutnya yang
dilakukan vyaitu mengumpulkan
sumber-sumber  materi  tentang
tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan
yang terdapat di Sumatera Utara
melalui buku, jurnal, maupun artikel
yang diakses secara online. Materi
yang telah terkumpul ini disusun
yang terdiri atas biografi tokoh,
perjuangan tokoh, strategi untuk
menentang/melawan penjajah, dan
juga peristiwa seputar perang yang
telah dilakukan oleh tokoh. Materi
yang dikumpulkan ini  berupa
tulisan, video, dan audio yang
nantinya akan disajikan pada media
pembelajaran interaktif.
Pengembangan Media/Pembuatan
Media Pembelajaran Interaktif

Pada tahapan ini merupakan
cara yang dilakukan peneliti dalam
mendesain  media pembelajaran
interaktif melalui penggunaan fitur-
fitur pada aplikasi Microsoft
Powerpoint 2016. Adapun kegiatan
ini terdiri atas:
Menyusun materi, yaitu dengan
memanfaatkan fitur-fitur  desain
tulisan yang tersedia pada halaman
home (Bentuk tulisan/font, ukuran
tulisan/font size, warna tulisan/font
color). Tulisan yang terdapat pada
media yang dikembangkan ini harus
terlihat atau terbaca dengan jelas
nantinya, sehingga pada tahap
menyusun  tulisan ini  harus
menyesuaikan antara bentuk tulisan,
ukuran tulisan, dan warna tulisan
yang digunakan.
Menyisipkan background.
Backgroung yang digunakan pada
media ini yaitu gambar yang
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diunduh secara gratis melalui
www.vecteezy.com yang kemudian
ditempelkan melalui Powerpoint.
Cara untuk menyisipkan gambar
sebagai latar tampilan yaitu, pada
menu Insert > Picture, klik gambar
yang akan menjadi background >
Sesuaikan dengan ukuran slide. Dan
supaya gambar nantinya tidak
menutupi tulisan pada slide, maka
posisikan gambar/background
menjadi  posisi  paling bawah,
dengan cara pada menu Format >
Send Backward > Send to Back.
Menyisipkan gambar.  Sebelum
menyisipkan gambar pada aplikasi
powerpoint, peneliti telah terlebih
dahulu mencari gambar-gambar
yang akan disisipkan pada produk.
Gambar-gambar tersebut peneliti
peroleh melalui pengunduhan secara
gratis  melalui internet/google.
Selanjutnya, untuk menyisipkan
gambar dapat dilakukan dengan
cara: pada menu Insert > Picture,
pilih gambar dan sesuaikan ukuran
gambarnya.  Untuk  mengubah
kecerahan atau kegelapan gambar
dapat dilakukan dengan cara klik
gambar > menu Format > pilih
Corrections, Color atau Artistic
Effects.

Menyisipkan audio/suara. Sebelum
menyisipkan audio, peneliti telah
terlebih dahulu melakukan rekam
suara Yyang berisikan penjelasan
materi. Rekam suara dilakukan
melalui Handphone. Sedangkan
untuk audio berupa lagu nasional,
dan musik telah diunduh secara
gratis melalui YouTube. Cara untuk
menyisipkan audio atau suara, yaitu:
pada menu Insert > Audio > Audio
On My PC.

Menyisipkan video. Video yang
peneliti  sisipkan pada media

pembelajaran interaktif tersebut
telah terlebih dahulu diunduh secara
gratis melalui YouTube. Adapun
cara untuk mrnyisipkan video, yaitu:
pada menu Insert > Video > Video
On My PC.

Membuat Transisi. Fitur transisi
pada Powerpoint digunakan oleh
peneliti  dalam mengembangkan
produk. Hal ini dilakukan untuk
membuat tampilan media
pembelajaran  interaktif  lebih
menarik dan mempercantik tiap
pemutaran antar halamannya. Cara
untuk membuat transisi  yaitu
dengan cara: klik slide yang akan
dibuat transisinya > pada menu
Transition pilih salah satu transisi.
Membuat Tombol Perintah. Pada
pembuatan tombol perintah ini
peneliti menggunakan fitur Shapes
pada powerpoint. Dengan cara, pada
menu Insert > klik Shapes > pilih
salah satu bentuk yang akan dibuat.
Sedangkan untuk icon seperti
rumah, volume, buku, video, dan
lainnya diunduh secara gratis
melalui internet.

Membuat Hyperlink. Menu
hyperlink pada powerpoint
berfungsi untuk mengatur fungsi
tombol apabila diklik nantinya akan
beralih pada tampilan yang
dikehendaki. Hal ini merupakan
kegiatan yang paling utama untuk
membuat media pembelajaran ini
menjadi interaktif dan menarik.
Cara untuk mengaktifkan fungsi
Hyperlink yaitu: klik tombol yang
akan dibuat fungsi hyperlink > pilih
menu Insert > klik Hyperlink > saat
muncul kotak dialog > Klik
hyperlink to, tentukan kepada
halaman berapa > OK.

Menyimpan Hasil Desain Media
Pembelajaran Interaktif


http://www.vecteezy.com/

Setelah media pembelajaran
interaktif telah selesai didesain,
maka langkah  akhir  dalam
pengembangan media ini yaitu
menyimpan hasil desain tersebut
agar nantinya media ini dapat
digunakan dalam proses
pembelajaran sejarah. Adapaun cara
menyimpan file tersebut yaitu
dengan cara klik file > klik save atau
lebih mudahnya dengan menekan
tombol Ctrl+S pada keyboard.
Mengimpor Produk Menjadi PPT
Web

Selain hasil dari media yang
dikembangkan disimpan menjadi
bentuk file slide powerpoint maka
media pembelajaran interaktif ini
juga akan dihasilkan menjadi bentuk
link akses yang nantinya link
tersebut akan dapat diakses secara
online. Tujuan dari menyimpan file
menjadi  bentuk PPT Web ini
dilakukan agar nantinya siswa tidak
perlu menginstal aplikasi Microsoft
Powerpoint di Handphone mereka,
dan juga siswa tidak perlu untuk
memiliki media ini dalam bentuk
file PPT karena mengingat ukuran
penyimpanan dari media yang
dikembangkan ini lumayan besar
yaitu 153 MB.

Adapun langkah-langkah
menyimpan file PPT menjadi
sebuah link, yaitu:

a) Login ke website
onedrive.live.com
b) Membuat akun di

onedrive.live.com
c) Buat folder baru di onedrive
d) Upload file PPT ke folder
onedrive yang telah dibuat
Berikut ini link akses media
pembelajaran interaktif berbasis
sejarah lokal materi tokoh dan
pahlawan dalam memperjuangkan
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kemerdekaan asal Sumater Utara:

https://1drv.ms/p/s!AgAcqKbidk0Q

hUwcA8dGAe9J1xqS?e=0IRPUj
3. Tahap llI: Melakukan Uji Validitas

Produk

Validasi materi dilakukan oleh Ibu
Dr. Rosmaida Sinaga, M.Hum dan
validasi media dilakukan oleh lbu Dr.
Samsidar  Tanjung, M.Pd, Kkedua
validator ini merupakan dosen jurusan
Pendidikan Sejarah, Fakultas llmu
Sosial, Universitas Negeri Medan. Uji
validitas produk ini dilakukan untuk
mengukur kelayakan produk yang telah
dikembangkan, selanjutnya validasi
materi dan validasi media ini dilakukan
sebanyak dua kali  dikarenakan
mengalami revisi/perbaikan berdasarkan
penilaian, kritik, dan saran dari ahli
materi dan ahli media.

Hasil  validasi  dari  media
pembelajaran interaktif berbasis sejarah
lokal materi tokoh nasional dan daerah
dalam memperjuangkan kemerdekaan
untuk kelas XI SMA Negeri 1 Bandar,
yaitu sebagai berikut:

a) Validasi Tahap Pertama

1) Validasi Ahli Materi

Penilaian  secara  keseluruhan
mendapatkan nilai 75 dari nilai jawaban
tertinggi 100 dengan persentase nilai
75% serta kategori penilaian umum yaitu
layak digunakan namun harus dilakukan
revisi. Adapun saran dan diberikan oleh
ahli materi, yaitu:

1) Tambahkan satu tokoh yang berasal
dari Mandailing.

2) Hapus gambar kartun/animasi pada
tampilan audio.

3) Buat tujuan pembelajaran.

4) Sesuaikan soal pada kuis dengan
KKO (Kata Kerja Operasional).

2) Validasi Ahli Media

Penilaian yang dilakukan oleh ahli
media terhadap media pembelajaran
interaktif yang dikembangkan secara
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keseluruhan mendapatkan nilai 95 dari
nilai jawaban tertinggi 116 dengan
persentase nilai 81,89% serta kategori
penilaian umum yaitu sangat layak
digunakan namun dilakukan revisi
media. Adapun saran dan masukan yang
diberikan oleh ahli media, yaitu:
1) Perbaiki pewarnaan latar

(Background).
2) Ukuran tulisan dan warna lebih

dikontraskan.
3) Materi lebih disederhanakan.
4) Audio diberi garis-garis besar materi

yang dijabarkan.
b) Validasi Tahap Kedua

1) Validasi Ahli Materi

Penilaian tahap kedua yang
dilakukan oleh ahli materi terhadap
media pembelajaran interaktif yang
dikembangkan  secara  keseluruhan
mendapatkan nilai akhir 95 dari nilai
jawaban tertinggi 100 dengan persentase
nilai 95% serta kategori sangat layak
digunakan tanpa dilakukan revisi media.
Dengan demikian pengembangan media
pembelajaran interaktif ini berhasil
mencapai tujuan dari penelitian yaitu
validasi produk akhir dari ahli materi.

2) Validasi Ahli Media

Penilaian tahap kedua yang
dilakukan oleh ahli media terhadap
media pembelajaran interaktif yang
dikembangkan  secara  keseluruhan
mendapatkan nilai akhir 111 dari nilai
jawaban tertinggi 116 dengan persentase
nilai 95,68% serta kategori sangat layak
digunakan tanpa dilakukan revisi media.
Dengan demikian pengembangan media
pembelajaran interaktif ini berhasil
mencapai tujuan dari penelitian yaitu
validasi produk akhir dari ahli media.
4. Tahap IV: Uji Coba Produk

Setelah produk telah dinyatakan
layak dan baik untuk digunakan, maka
selanjutnya juga perlu dilakukan uji coba
produk kepada siswa. Dilakukannya uji

coba produk ini untuk melihat dan
mengetahui respon atau tanggapan siswa
dalam hadirnya media pembelajaran
interaktif berbasis sejarah lokal materi
tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan dalam
pembelajaran sejarah di sekolah. Dalam
Model Pengembangan Lima Tahap
(Mantap) oleh Sumarni, uji coba produk
ini dilakukan dua tahap, yaitu uji coba
kelompok terbatas, dan uji coba
kelompok luas. Adapun hasil uji coba
produk, yaitu sebagai berikut:

1) Uji Coba Produk Pada Kelompok

Terbatas

Uji coba produk terlebih dahulu
diujikan kepada kelompok terbatas. Uji
coba produk pada kelompok terbatas ini
dilakukan kepada 10 siswa yang bukan
berasal dari kelas sampel penelitian.
Penelitian ini dilakukan kepada siswa
kelas XI IPS 2, X1 IPS 3, XI IPS 4, XI
IPS 5, dan XI IPS 6 yang masing-masing
perkelasnya diwakilkan oleh dua orang
siswa. Pada tahap ini siswa memberikan
tanggapan atau respon penilaian terhadap
media pembelajaran interaktif berbasis
sejarah lokal materi tokoh nasional dan
daerah dalam memperjuangkan
kemerdekaan berdasarkan aspek
isi/materi, aspek media, kebahasaan dan
manfaat.

Berdasarkan penilaian kelompok
terbatas terhadap media pembelajaran
interaktif berbasis sejarah lokal materi
tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan yang
dikembangkan menghasilkan
keseluruhan skor penilaian sebesar 3,58
dari skor maksimal 4,00. Dari tabel
tersebut juga dapat diilihat hasil respon
siswa terhadap tiap aspek penilaian, yaitu
aspek isi/materi sebesar 89,16% dengan
kategori “sangat layak”, aspek media
sebesar 90,41% dengan kategori “sangat
layak”, aspek kebahasaan sebesar 90%
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dengan kategori “sangat layak”, dan
aspek manfaat sebesar 88,75% dengan
kategori “sangat layak”. Berdasarkan
persentase tiap aspek ini  dapat
disimpulkan bahwa media pembelajaran
interaktif yang dikembangkan
mendapatkan nilai persentase
keseluruhannya sebesar 89,79% dengan
kategori sangat layak.

Dari hasil penilaian tersebut, dapat
disimpulkan bahwa media pembelajaran
interaktif berbasis sejarah lokal materi
tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan sangat
layak digunakan dalam pembelajaran
sejarah, dengan  persentase nilai
keseluruhan sebesar 89,79%, maka
media pembelajaran interaktif yang
dikembangkan tidak lagi dilakukan revisi
produk.

2) Uji Coba Produk Pada Kelompok

Luas

Setelah media pembelajaran
interaktif berbasis sejarah lokal telah
diperbaiki (revisi) dan divalidasi kembali
oleh ahli materi, ahli media, dan juga
telah dilakukan uji coba produk pada
kelompok terbatas, maka selanjutnya
media pembelajaran interaktif ini di uji
coba produk kembali pada proses
pembelajaran Sejarah Indonesia dikelas
X1 IPS 1 SMA Negeri 1 Bandar dengan
jumlah 36 siswa. Masing-masing siswa
memberikan respon penilaian
berdasarkan aspek isi/materi, aspek
media, kebahasaan dan manfaat terhadap
penggunaan media pembelajaran
interaktif berbasis sejarah lokal materi
tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan pada
pembelajaran sejarah. Namun, penelitian
terhadap siswa kelas XI IPS 1
dilaksanakan sebanyak 2 kali pertemuan,
dikarenakan adanya peraturan proses
pembelajaran selama pandemi Covid-19.
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Adapun langkah-langkah penelitian
yang dilakukan sebagai berikut:

1) Memperkenalkan diri dan
menyampaikan tujuan  penelitian
kepada guru dan siswa.

2) Bertukar informasi dan pengetahuan
tentang tokoh-tokoh daerah yang
berasal dari Sumatera Utara yang
telah memperjuangkan kemerdekaan.

3) Menyampaikan pentingnya untuk
mengetahui dan menghargai
perjuangan yang telah dilakukan oleh
tokoh-tokoh lokal.

4) Mensosialisasikan dan menjelaskan
cara penggunaan dari  Media
Pembelajaran  Interaktif — Berbasis
Sejarah Lokal Materi Tokoh Nasional
dan Daerah dalam Memperjuangkan
Kemerdekaan Asal Sumatera Utara.

5) Memberikan link akses media
pembelajaran interaktif yang nantinya
akan diakses melalui ppt web dengan
handphone.
Link:https://1drv.ms/p/s!AgAcqKbid
kOQhUwcA8dGAe9J1xqS?e=0IRPU
J

6) Memberikan kesempatan kepada
siswa untuk belajar secara mandiri
dan mengerjakan Kkuis interaktif
dengan menggunakan media
pembelajaran interaktif  berbasis
sejarah lokal.

7) Setelah itu, meminta perwakilan dari
siswa untuk mengemukakan apa yang
telah dipahami dan dipelajari dari
media tersebut.

8) Langkah terakhir pada penelitian ini
yaitu meminta siswa untuk mengisi
instrumen penelitian (angket uji coba
produk) vyang telah disediakan.
Angket berbentuk kertas pada saat
penelitian luar jaringan (luring) dan
angket melalui google form saat
penelitian dalam jaringan (daring).
Berdasarkan data penilaian yang

dihasilkan melalui uji coba pemakaian
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produk kepada kelompok luas (kelas XI
IPS 1) diperoleh berdasarkan angket
yang telah memperoleh keseluruhan skor
penilaian 3,71 dari skor maksimal 4,00
dengan persentase 91,37% serta kategori
“sangat layak”. Adapun penilaian tiap
aspek yang diperoleh, yaitu aspek
isi/materi ~ memperoleh  persentase
90,50% dengan kategori “sangat layak”,
aspek media memperoleh persentase
89,58% dengan kategori “sangat layak”,
aspek kebahasaan memperoleh
persentase 96,52% dengan Kkategori
“sangat layak”, dan aspek manfaat
memperoleh persentase 95,48% dengan
kategori “sangat layak”.

Dari hasil penilaian tersebut, dapat
disimpulkan bahwa media pembelajaran
interaktif berbasis sejarah lokal materi
tokoh nasional dan daerah dalam
memperjuangkan kemerdekaan sangat
layak digunakan dalam pembelajaran
sejarah, dengan  persentase  nilai
keseluruhan sebesar 91,37%, maka
media pembelajaran interaktif yang
dikembangkan sudah sangat layak
digunakan sebagai sebuah  media
pembelajaran sejarah dikelas dan tidak
lagi dilakukan revisi produk.

5. Tahap V: Diseminasi

Setelah  produk telah  berhasil
dikembangkan, divalidasi oleh ahli, dan
juga telah diuji coba produk terhadap
siswa, maka selanjutnya yaitu melakukan
tahap diseminasi yang menjadi tahap
akhir dari penelitian ini. Pada penelitian
ini  dilakukan diseminasi ataupun
sosialisasi kepada seluruh mahasiswa
jurusan Pendidikan Sejarah Universitas
Negeri Medan  Stambuk  2019.
Diseminasi ini dilakukan pada tanggal 25
Maret 2022 di ruang kuliah Jurusan
Pendidikan Sejarah Unimed. Adapun
tujuan dilakukannya diseminasi ini yaitu
memperkenalkan,  menginformasikan,
dan melakukan sosialsasi tentang

pengembangan media pembelajaran
interaktif berbasis sejarah lokal materi
tokoh nasional dan daerah dalam
memperjuangkan  kemerdekaan asal
Sumatera Utara.

KESIMPULAN
Berdasarkan hasil penelitian dan

pembahasan mengenai pengembangan
media pembelajaran interaktif berbasis
sejarah lokal materi tokoh nasional dan
daerah dalam memperjuangkan
kemerdekaan dapat disimpulkan sebagai
berikut:

1. Pada penelitian pengembangan ini
menghasilkan sebuah produk berupa
media  pembelajaran  interaktif
sejarah lokal materi tokoh nasional
dan daerah dalam memperjuangkan
kemerdekaan kelas X1 SMA Negeri
1 Bandar yang didesain dengan
berbantuan pada aplikasi Microsoft
Powerpoint. Pada penelitian ini
menggunakan jenis dari Model
Pengembangan Lima Tahap
(Mantap) yang dikembangan oleh
Sumarni yang terdiri atas 5 tahapan,
yaitu tahap l: Penelitian
Pendahuluan, tahap I
Pengembangan Produk, tahap IlI:
Uji Validitas Produk, tahap 1V: Uji
Coba Produk, dan tahap V:
Diseminasi. Media pembelajaran
interaktif yang dikembangkan ini
berisikan materi tentang tokoh-
tokoh nasional dan daerah yang
berasal dari Sumatera Utara yang
terdiri atas biografi tokoh, peran dan
strategi perlawanan yang dilakukan
terhadap penjajah, dan keteladanan
dari tokoh. Materi dalam produk ini
tentu telah disesuaikan terlebih
dahulu terhadap kompetensi dasar
dan materi pokok dari silabus dan
RPP mata pelajaran  Sejarah
Indonesia kelas XI semester 2 yang
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digunakan oleh guru. Selanjutnya,
media yang dikembangkan ini
memuat materi yang tersaji dalam
bentuk gambar, audio, dan video
serta terdapat kuis interaktif yang
berfungsi sebagai umpan balik bagi
siswa setelah mempelajari materi.
Hasil penelitian yang diperoleh
menunjukkan bahwa media
pembelajaran interaktif berbasis
sejarah lokal materi tokoh nasional
dan daerah dalam memperjuangkan
kemerdekaan untuk kelas XI SMA
Negeri 1 Bandar yang
dikembangkan layak untuk
digunakan sebagai media dalam
proses pembelajaran sejarah. Pada
validasi materi tahap pertama
memperoleh persentase nilai 75%
dengan kategori layak dan revisi
produk, dan validasi materi tahap
kedua setelah revisi  produk
mendapatkan persentase nilai yang
meningkat yaitu sebesar 95%
dengan kategori sangat layak.
Kemudian, validasi media tahap
pertama memperoleh persentase
nilai 81,89% dengan kategori sangat
layak namun harus melakukan revisi
produk. Setelah itu, validasi media
tahap kedua setelah revisi produk
menghasilkan persentase nilai yang
meningkat yaitu sebesar 95,68%
dengan kategori sangat layak. Uji
coba produk pada kelompok terbatas
memperoleh persentase  nilai
89,79% dengan kategori sangat
layak, dan uji coba produk pada
kelompok luas memperoleh 91,37%
dengan Kkategori sangat layak.
Setelah produk berhasil
dikembangkan maka selanjutnya
dilakukan diseminasi dengan cara
presentasi kepada seluruh
mahasiswa  jurusan  Pendidikan
Sejarah Unimed Stambuk 2019.
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